ABSTRACT

Although active filters are vital in modern electronics, their design and verification can be tedious and time-consuming. The FilterPro program is designed to aid in the design of active filters implemented with the multiple feedback (MFB) and Sallen-Key topology. This user’s guide describes the information the designer must enter into the program and what the program delivers.

Contents

1 Filter Type Definitions ................................................................. 3
2 Filter Responses ....................................................................... 7
3 Circuit Implementation ............................................................. 8
4 Using FilterPro Desktop v3.1 ....................................................... 11
5 Changing Components in FilterPro Desktop ............................... 22
6 Capacitor Selection ................................................................. 23
7 Op Amp Selection .................................................................... 23
8 The UAF42 Universal Active Filter ............................................ 25
9 Design Tools ........................................................................... 26
10 Migrating Designs from FilterPro v2.0 ......................................... 31
11 Important Notes ....................................................................... 32
12 Conclusion ............................................................................... 37

List of Figures

1 Low-Pass Filter Response .......................................................... 3
2 High-Pass Filter Response .......................................................... 4
3 Bandpass Filter Response .......................................................... 5
4 Band-Reject or Bandstop Filter .................................................. 6
5 Response vs Frequency of Even-Order (Four-Pole), 3dB Ripple Chebyshev Filter Showing Cutoff at 0dB ................................................................. 7
6 Response vs Frequency of Odd-Order (Five-Pole), 3dB Ripple Chebyshev Filter Showing Cutoff at −3dB ................................................................. 7
7 Real Pole Section (Unity-Gain, First-Order Butterworth; f \(3dB = 1/2 \pi R_1 C_1\) ) .................................................. 9
8 Second-Order Low-Pass Filter .................................................... 9
9 Third-Order Low-Pass Filter ...................................................... 9
10 Even-Order Low-Pass Filter using Cascaded Complex Pole-Pair Sections .................................................. 9
11 Odd-Order Low-Pass Filter using Cascaded Complex Pole-Pair Sections Plus One Real-Pole Section .......... 9
12 MFB Complex Pole-Pair Section (Gain = −R_0/R_1) ....................... 10
13 Sallen-Key Complex Pole-Pair Section, Unity-Gain (Gain = 1) .......... 10
14 Sallen-Key Complex Pole-Pair Section (Gain = 1 + R_0/R_1) .......... 10
15 Using the FilterPro Design Wizard ............................................ 12
16 Filter Specification Entry Screen .............................................. 13
17 Filter Response Selection Screen ............................................ 15
18 Filter Topology Selection Screen ........................................... 16
Main Screen, Schematic Tab ................................................................. 17
Data Tab .......................................................................................... 18
BOM Tab ......................................................................................... 18
Comments Tab ............................................................................... 19
Design Report Tab .......................................................................... 19
File Menu ....................................................................................... 20
File Save Directory Dialog .............................................................. 20
Design List ..................................................................................... 21
Design List: My Designs ................................................................. 21
Changing Component Values .......................................................... 22
Component Tolerance Selection ..................................................... 23
Example Fully-Differential MFB Filter Designed by FilterPro 3.1 ................................................. 25
Export to Excel Button .................................................................. 26
Print a Design Report Through the Printer Icon in the Upper Left Toolbar Area ...................... 27
Save a Design from the File Menu .................................................. 28
Save As... Dialog .......................................................................... 28
Selecting a Design from the Design Manager ................................... 29
Opening a Design from the File Menu ............................................ 29
Opening a Design from the Toolbar Icon ........................................... 29
Design Manager Contextual Menu .................................................. 30
Rename Dialog .............................................................................. 30
Open Design from File Menu .......................................................... 31
Specifying and Opening FilterPro v2.0 Format Files ................................. 31
Windows 7 Desktop Properties Selection .......................................... 32
Setting Privilege Level in Desktop Properties ..................................... 32
Correct Look of Filter Design Wizard ................................................ 33
Incorrect Look of Filter Design Wizard ............................................. 33
Selecting Properties from Desktop Contextual Menu .............................. 34
Settings Button in System Properties ................................................ 35
Selecting Performance Options .......................................................... 35
Gain vs Frequency for Fifth-Order 20kHz Butterworth, Chebyshev, and Bessel Unity-Gain MFB
Low-Pass Filters, Showing Overall Filter Response ........................................ 36
Gain vs Frequency for Fifth-Order 20kHz Butterworth, Chebyshev, and Bessel Unity-Gain MFB
Low-Pass Filters, Showing Transition-Band Detail ........................................ 36
Step Response of Fifth-Order, 20kHz Butterworth Low-Pass MFB Filter ............................................. 37
Step Response of Fifth-Order, 20kHz Chebyshev Low-Pass MFB Filter ............................................. 37
Step Response of Fifth-Order, 20kHz Bessel Low-Pass MFB Filter ..................................................... 37
Measured Distortion for the Three 20kHz MFB Low-Pass Filters ..................................................... 37
1 Filter Type Definitions

Electronic filters are applied in applications where a specific amplitude versus frequency behavior is required from a circuit. Other applications exist where a specific phase shift, or time delay, needs to be incorporated in a circuit and a filter may be used in those applications as well. FilterPro has been designed to synthesize filters that purposely affect the frequency or time characteristics of a signal.

The Texas Instruments FilterPro™ program makes it easy to design low-pass, high-pass, bandpass, band reject, and all-pass active filters. These five filter types are defined in this section.

1.1 Low-Pass Filters

Low-pass filters are the most widely applied filter type. They are designed to readily pass all frequencies extending from dc to a set cutoff frequency, $f_c$; refer to Figure 1. This region where the frequencies readily pass through the filter is called the passband, and $f_c$ is defined as the filter bandwidth.

Once the cutoff frequency is reached, the filter begins to attenuate any frequency higher than $f_c$. The region above $f_c$ is called the stopband. Most often the attenuation increases, or rolls off, and achieves very high levels which are limited only by the non-ideal electronics used to construct the filter. These include the stray and lead inductance of the capacitors, non-ideal operational amplifier limitations, and circuit parasitics associated with the physical circuit layout.
### 1.2 High-Pass Filters

The high-pass filter, as shown in Figure 2, has a passband where all frequencies above the cutoff frequency \( f_c \) pass with little to no attenuation. Below \( f_c \), within the filter's stop-band, the signals are attenuated at ever greater levels as the frequency moves lower.

![Figure 2. High-Pass Filter Response](image-url)
1.3 Bandpass Filters

The bandpass filter has a passband that allows a select band of frequencies that fall within the passband to pass with little, or no, attenuation; refer to Figure 3. An upper \(f_H\) and lower \(f_L\) cutoff frequency define the bandwidth of the filter \((f_H \text{ to } f_L)\). Frequencies beyond the passband lie in the two stopbands and receive greater attenuation as the frequency moves further away from the passband in either direction.

![Figure 3. Bandpass Filter Response](image-url)
1.4 **Band-Reject or Bandstop Filters**

The bandstop, or band-reject filter, is sometimes referred to as a *notch filter* due to its notch-like gain versus frequency stopband characteristic, which is illustrated in Figure 4. The purpose of this filter type is to attenuate, or reject, frequencies that fall within the stopband. The filter bandwidth is defined by upper and lower cutoff frequencies like the bandpass filter.

![Figure 4. Band-Reject or Bandstop Filter](image)

1.5 **All-Pass Filters**

The all-pass filter function passes all frequencies equally well (or at least within the intended passband) with a specific phase shift or time behavior being of primary concern. For example, an all-pass filter can be designed with a specified $-45^\circ$ input-to-output phase shift at 1kHz. Note that the amplitude vs. frequency plot would be flat throughout its entire range. Often, a simple first-order, all-pass filter is sufficient to achieve the required phase-shift. Keep in mind that the phase shift will be different from $-45^\circ$ at other input frequencies.

All-pass filters can be optimized for a particular time delay; for example, 159\(\mu\)s at a 1kHz input frequency. The phase shift for this filter is found by:

$$\varphi = -\frac{t_d}{t_p} (360^\circ) = -\frac{(159\mu s/1ms)(360^\circ)}{360^\circ} = -57.2^\circ$$

Where: \(t_d\) = delay time and \(t_p\) = period time.
2 Filter Responses

An ideal low-pass filter would completely eliminate signals above the cutoff frequency, and perfectly pass signals below the cutoff (in the passband). This ideal, brick-wall response is shown in Figure 1 through Figure 4. In real filters, various tradeoffs are made attempting to approximate the ideal. Some filter responses are optimized for gain flatness in the passband; some trade off gain variation (ripple) in the passband for steeper roll-off; still others trade off both flatness and rate of roll-off in favor of pulse-response fidelity. FilterPro supports several commonly-used filter responses: Butterworth, Chebyshev, Bessel, Gaussian, and Linear-Phase.

2.1 Butterworth (Maximally Flat Magnitude)

This filter has the flattest possible passband magnitude response. Attenuation is –3dB at the design cutoff frequency. Attenuation above the cutoff frequency is a moderately steep –20dB per decade per pole. The pulse response of the Butterworth filter has moderate overshoot and ringing. It has good all-around performance. Its pulse response is better than Chebyshev, and its rate of attenuation is better than that of Bessel.

2.2 Chebyshev (Equal Ripple Magnitude)

Note: Mr. Chebyshev's name is also transliterated Tschebychev, Tschebyscheff, or Tchevysheff.

This filter response has steeper attenuation above the cutoff frequency than Butterworth. This advantage comes at the penalty of amplitude variation (ripple) in the passband. Unlike Butterworth and Bessel responses, which have 3dB attenuation at the cutoff frequency, the Chebyshev cutoff frequency is defined as the frequency at which the response falls below the ripple band. For even-order filters, all ripple is above the 0dB-gain dc response, so cutoff is at 0dB (as Figure 5 shows). For odd-order filters, all ripple is below the 0dB-gain dc response, so cutoff is at –(ripple)dB, as Figure 6 illustrates. For a given number of poles, a steeper cutoff can be achieved by allowing more passband ripple. The Chebyshev has considerable ringing in its pulse response compared to the Butterworth type.
2.3 **Bessel (Maximally Flat Time Delay)**

Also called the Thomson filter, this filter has excellent pulse response (that is, minimal overshoot and ringing) due to its linear phase response. These filter types are often used in audio crossover systems. Analog Bessel filters are characterized by almost constant group delay across the entire passband, thus preserving the wave shape of filtered signals in the passband. For a given number of poles, its magnitude response is not as flat, nor is its attenuation beyond the –3dB cutoff frequency as steep as the Butterworth. Although it takes a higher-order Bessel filter to give a magnitude response which approaches that of a given Butterworth filter, the pulse response fidelity of the Bessel filter may make the added complexity (because of the need for additional filter sections) worthwhile.

2.4 **Gaussian (Minimum Group Delay)**

This type of filter has an impulse response that is a Gaussian function. Gaussian filters are designed to give no overshoot to a step function input while minimizing the rise and fall time. This behavior is closely connected to the fact that the Gaussian filter has the minimum possible group delay.

2.5 **Linear-Phase (Equi-Ripple Delay)**

Similar to the Bessel response, this filter response has a phase response that is a linear function of the frequency. While the Bessel has a maximally-flat time delay, these filters approximate linear phase to within a given ripple (0.5 degrees or 0.05 degrees). They have a sharper magnitude response than the Bessel filter, sometimes allowing for a lower-order filter to be used to achieve a desired attenuation at a specific frequency. The step response has slightly more overshoot than Bessel filters.

3 **Circuit Implementation**

Even-order filters designed with this program consist of cascaded sections of complex pole-pairs. Odd-order filters contain an additional real-pole section. Figure 7 through Figure 11 show the recommended cascading arrangement. The figures show the additional real-pole section ahead of the other sections, but some configurations are better with the real-pole section following (see Figure 16). The program automatically places lower Q stages ahead of higher Q stages to prevent op amp output saturation due to gain peaking. The program can be used to design low-pass, high-pass, and all-pass filters up to the 10th order. Bandpass and bandstop filters up to the 20th order may also be designed with FilterPro since each low-pass pole-zero pair can be transformed into a second-order stage.

Table 1 lists the filter order and relevant example circuit.

<table>
<thead>
<tr>
<th>Filter Order</th>
<th>Figure</th>
</tr>
</thead>
<tbody>
<tr>
<td>One pole</td>
<td>Figure 7</td>
</tr>
<tr>
<td>Two poles</td>
<td>Figure 8</td>
</tr>
<tr>
<td>Three poles</td>
<td>Figure 9</td>
</tr>
<tr>
<td>Four or more poles (even order)</td>
<td>Figure 10</td>
</tr>
<tr>
<td>Five or more poles (odd poles)</td>
<td>Figure 11</td>
</tr>
</tbody>
</table>
Figure 7. Real Pole Section (Unity-Gain, First-Order Butterworth; \( f_{-3dB} = \frac{1}{2\pi R_1 C_1} \))

Figure 8. Second-Order Low-Pass Filter

Figure 9. Third-Order Low-Pass Filter

Figure 10. Even-Order Low-Pass Filter using Cascaded Complex Pole-Pair Sections

Figure 11. Odd-Order Low-Pass Filter using Cascaded Complex Pole-Pair Sections Plus One Real-Pole Section
### 3.1 Complex Pole-Pair Circuit

The choice of a complex pole-pair circuit depends on performance requirements. FilterPro supports the two most commonly used active pole-pair circuit topologies:

- Multiple Feedback (MFB), illustrated in Figure 12
- Sallen-Key, shown in Figure 13 and Figure 14

#### Figure 12. MFB Complex Pole-Pair Section
(Gain = \(-\frac{R_2}{R_1}\))

#### Figure 13. Sallen-Key Complex Pole-Pair Section,
Unity-Gain (Gain = 1)

#### Figure 14. Sallen-Key Complex Pole-Pair Section (Gain = 1 + \(\frac{R_4}{R_3}\))

### 3.2 MFB Topology

The MFB topology (sometimes called *Infinite Gain* or *Rauch*) is often preferred due to assured low sensitivity to component variations. The MFB topology creates an inverting second-order stage. In designs where an even number of stages are required, the output polarity will be the same as the input; this may not always be the case for filters employing the MFB because each stage brings about an output-to-input inversion. A sixth-order filter consisting of three MFB stages would invert three times, resulting in an inverted output after the third stage. This inversion may, or may not, be a concern in the filter application.

FilterPro also allows designing fully-differential MFB stages, where the inversion may be less of an issue because of the fully differential nature of the circuit.
3.3 **Sallen-Key Topology**

There are instances where the Sallen-Key topology is a better choice. The Sallen-Key is a noninverting circuit, which may make it preferable over the MFB, but this is not the only potential advantage. As a rule of thumb, the Sallen-Key topology is better if:

1. Gain accuracy is important, *and*
2. A unity-gain filter is used, *and*
3. Pole-pair Q is low (for example, Q < 3)

At unity-gain, the Sallen-Key topology inherently has excellent gain accuracy. This is because the op amp is used as a unity-gain buffer. With the MFB topology, gain is determined by the $R_2/R_1$ resistor ratio. The unity-gain Sallen-Key topology also requires fewer components—two resistors versus three for the MFB.

The Sallen-Key topology may also be preferable for high-Q, high-frequency filter sections. In these sections, the value required for $C_1$ in an MFB design can be quite low for reasonable resistor values. Low capacitor values can result in significant errors due to parasitic capacitance.

The best filter design may be a combination of MFB and Sallen-Key sections. To do this, use FilterPro to define the component values of the same design using both circuit types, and then use some of the sections from one design with some from the other design to build your filter design.

4 **Using FilterPro Desktop v3.1**

FilterPro Desktop v3.1 allows you to design active filters of different types and responses for Sallen-Key and Multiple Feedback topologies. Use this tool to create, manage, and share custom active-filter designs.

4.1 **Computer Requirements**

The system requirements for FilterPro are:

- 1GHz processor or faster
- 2GB RAM or greater
- At least 250MB of free hard-disk space
- Minimum 1024 x 768 display
- Microsoft® Windows® XP with SP3 and Microsoft .NET Framework 3.5 or higher

It is helpful, but not required, to have a printer available, either locally or on a network.

4.2 **Installation**

To install FilterPro on your computer, run the setup program which you can download from [http://www.ti.com/filterpro-pr](http://www.ti.com/filterpro-pr).
4.3 Creating Designs in FilterPro Desktop

When FilterPro starts, you are presented with the Filter Design Wizard, as shown in Figure 15.

There are three main areas of the Design Wizard:

1. **Summary**: This area shows you where you are in the design creation process.

2. **Active Design Area**: This area is interactive. Select the filter type and enter required values for your new design.

3. **Back/Next and Exit Wizard**: Click **Back** or **Next** to walk through your design before finalizing it. If there is no need to use the Design Wizard, click **Exit Wizard**.

The Design Wizard takes you through four steps to help you build active filter designs quickly. The Design Wizard appears when you initially open the application. If the Design Wizard is closed, you can create a design by accessing the **File** menu in the page header.

*Figure 15. Using the FilterPro Design Wizard*
4.3.1 Step 1. Filter Type

Select the type of filter needed. The Design Wizard offers the following filter types:

1. Low-pass
2. High-pass
3. Bandpass
4. Bandstop/Notch
5. All-pass (Time Delay)

Once the appropriate filter is selected, click Next to proceed to Step 2.

4.3.2 Step 2. Filter Specifications

Figure 16. Filter Specification Entry Screen

Enter the filter specifications for the filter type chosen in Step 1.

The specifications for the filters are:

- **Gain** ($A_0$): Enter the overall gain required for the filter in volts per volt (V/V) or decibels (dB). The gain value is automatically converted to the other unit if you did not enter it. For example, if you enter ‘1’ in the V/V box, the value ‘0dB’ is automatically entered by the application, and vice-versa.
- **Passband Frequency** ($f_c$): Enter the passband frequency of the filter type chosen in hertz (Hz)
- **Allowable Passband Ripple** ($R_p$): Enter the maximum allowable passband ripple in decibels (dB), in the range of 0 to 3dB.
- **Stopband Frequency** ($f_s$): Enter the stopband frequency of the filter type chosen in hertz (Hz).
- **Stopband Attenuation** ($A_{SB}$): Enter the stopband attenuation of the filter type chosen in decibels (dB).
- **Filter Order**: Check the **Set Fixed** button if you want to force the order (up to 10) of the filter.
Using FilterPro Desktop v3.1

- **High-pass:**
  - **Gain** ($A_0$): Enter the overall gain required for the filter in volts per volt (V/V) or decibels (dB). The gain value is automatically converted to the other unit if you did not enter it. For example, if you enter ‘1’ in the V/V box, the value ‘0dB’ is automatically entered by the application, and vice-versa.
  - **Passband Frequency** ($f_c$): Enter the passband frequency of the filter type chosen in hertz (Hz).
  - **Allowable Passband Ripple** ($R_p$): Enter the maximum allowable passband ripple in decibels (dB), in the range of 0 to 3dB.
  - **Stopband Frequency** ($F_s$): Enter the stopband frequency of the filter type chosen in hertz (Hz).
  - **Stopband Attenuation** ($A_{sb}$): Enter the stopband attenuation of the filter type chosen in decibels (dB).
  - **Filter Order**: Check the **Set Fixed** button if you want to force the order (up to 10) of the filter.

- **Bandpass:**
  - **Gain** ($A_0$): Enter the overall gain required for the filter in volts per volt (V/V) or decibels (dB). The gain value is automatically converted to the other unit if you did not enter it. For example, if you enter ‘1’ in the V/V box, the value ‘0dB’ is automatically entered by the application, and vice-versa.
  - **Center Frequency** ($f_o$)
  - **Allowable Passband Ripple** ($R_p$): Enter the maximum allowable passband ripple in decibels (dB), in the range of 0 to 3dB.
  - **Passband Bandwidth** ($BW_p$): Enter the passband bandwidth of the filter type chosen.
  - **Stopband Bandwidth** ($BW_s$): Enter the stopband bandwidth of the filter type chosen.
  - **Stopband Attenuation** ($A_{sb}$): Enter the stopband attenuation of the filter type chosen in decibels (dB).
  - **Filter Order**: Check the **Set Fixed** button if you want to force the order (up to 10) of the filter.

- **Bandstop/Notch:**
  - **Gain** ($A_0$): Enter the overall gain required for the filter in volts per volt (V/V) or decibels (dB). The gain value is automatically converted to the other unit if you did not enter it. For example, if you enter ‘1’ in the V/V box, the value ‘0dB’ is automatically entered by the application, and vice-versa.
  - **Center Frequency** ($f_o$)
  - **Allowable Passband Ripple** ($R_p$): Enter the maximum allowable passband ripple in decibels (dB), in the range of 0 to 3dB.
  - **Passband Bandwidth** ($BW_p$): Enter the passband bandwidth of the filter type chosen.
  - **Stopband Bandwidth** ($BW_s$): Enter the stopband bandwidth of the filter type chosen.
  - **Stopband Attenuation** ($A_{sb}$): Enter the stopband attenuation of the filter type chosen in decibels (dB).
  - **Filter Order**: Check the **Set Fixed** button if you want to force the order (up to 10) of the filter.

- **All-pass (Time Delay):**
  - **Gain** ($A_0$): Enter the overall gain required for the filter in volts per volt (V/V) or decibels (dB). The gain value is automatically converted to the other unit if you did not enter it. For example, if you enter ‘1’ in the V/V box, the value ‘0dB’ is automatically entered by the application, and vice-versa.
  - **Passband Frequency** ($f_c$): Enter the passband frequency of the filter type chosen in hertz (Hz).
  - **Phase Delay at** $f_c$ ($To$): Enter the phase delay of the filter type chosen.
  - **Approx. Phase Shift** at $f_c$ ($s$): Enter the approximate phase shift delay of the filter type chosen.
  - **Filter Order**: Check the **Set Fixed** button if you want to force the order (up to 10) of the filter.
### 4.3.3 Step 3. Filter Response

This step allows you to choose the response of the filter type you chose in Step 1.

FilterPro offers these filter responses:
- Bessel
- Butterworth
- Chebyshev 0.5dB
- Chebyshev 1dB
- Chebyshev with ripple value entered in *Allowable Passband Ripple* box (in Figure 17, for example, a 1.5dB Chebyshev filter has also been shown, because 1.5 was the value entered into the *Allowable Passband Ripple* box).
- Gaussian to 12dB
- Gaussian to 6dB
- Linear Phase 0.05 degrees
- Linear Phase 0.5 degrees

Choose the response type by selecting the respective radio button.

This step also shows a preview of the plots of the design. The available plots are the gain and phase responses and group delay.

---

*Figure 17. Filter Response Selection Screen*

This step allows you to choose the response of the filter type you chose in Step 1.

FilterPro offers these filter responses:
- Bessel
- Butterworth
- Chebyshev 0.5dB
- Chebyshev 1dB
- Chebyshev with ripple value entered in *Allowable Passband Ripple* box (in Figure 17, for example, a 1.5dB Chebyshev filter has also been shown, because 1.5 was the value entered into the *Allowable Passband Ripple* box).
- Gaussian to 12dB
- Gaussian to 6dB
- Linear Phase 0.05 degrees
- Linear Phase 0.5 degrees

Choose the response type by selecting the respective radio button.

This step also shows a preview of the plots of the design. The available plots are the gain and phase responses and group delay.

---

*Figure 17. Filter Response Selection Screen*
4.3.4 Step 4. Filter Topologies

Select from the available topologies. These are Multiple-Feedback (single-ended or fully-differential) and Sallen-Key.

Choose the respective radio button for the topology you wish to use. The topology preview is displayed.

Click Finish to create a new design. The design will appear on the screen after a few seconds. If you are satisfied with your design (and before any other changes are made), save your design to prevent losing the work you have done.
4.3.5 Step 5. Interacting with the Design

Figure 19. Main Screen, Schematic Tab

4.3.5.1 Schematic Tab

When a design is created or opened, this is the default view in the program. This tab displays the name and specifications used to create the design at the top. The schematic has a few features to help you easily change information:

- **Schematic**: The schematic is displayed, followed by the gain and phase response for the filter created. Group Delay is plotted as well.

Above the schematic at the top right corner, you can change component tolerances. Refer to Changing Component Values for more information.

- **Reset**: The Reset button is located beside the component tolerances. This button allows you to reset the design to its original form before any changes were made. It does not simply undo the last action. This button resets your design—meaning that the design specifications are kept the same but the component value changes, if any, are lost and the design reverts back to its original state. For example, you may have changed the component values for the design four times. If you hit the Reset button, the program will take you back to the original component values chosen when the design was created the first time.

- **Red Label**: See information about the design. These labels cannot be edited.

- **Blue Label**: Modify information for the items in blue by mousing over the label and changing values.

- **Zoom**: Zoom into the design by placing the mouse over the graph and using the mouse wheel to zoom in or out of the graph

- **Pan**: Place the mouse over the graph. Press the left mouse button and drag it around the graph to view information as needed.
4.3.5.2 Data Tab

This tab contains information at all frequencies. The information is displayed at low, high and corner frequencies. The data displayed are Gain, Phase and Group Delay. The information in this tab can be exported to Microsoft Excel® or other spreadsheet programs.

4.3.5.3 BOM Tab

This tab shows the bill of materials of the created design. It contains information about the components used, including name, value, type, tolerance, manufacturer, and quantity. The resistors and capacitors, at this point, are standard. The op amps shown are ideal. The information in this tab can be exported to Excel.
4.3.5.4 Comments Tab

In this tab, you can add notes relating to the design being stored. You can add any comments you want about the design. This information is saved when you open the design again.

4.3.5.5 Design Report Tab

This tab allows you to view a design report of the created design. It includes the specifications used to create the design, schematic, gain and phase responses, group delay plot, response data at key frequencies, and the bill of materials. This tab gives you the option to print a report of all the information that has been generated about the design.
4.3.6 Save Your Design

To save your design, select File from the menu bar and then select Save Design.

The window that opens is the default location where your files will be saved when working in FilterPro. You can either use the default location and save your files in this directory (you can also create sub-directories), or you can choose to save your files in a directory that is more convenient for you.

**NOTE:** All FilterPro designs contain the extension .fpd.

To see files saved in FilterPro v3.1 in the Design List window, they must be saved in the default FilterPro directory. The default location for designs is $\My\Documents\Texas\Instruments\FilterPro\My\Designs. If a file is saved in another directory on your desktop, the designs will NOT appear in the Design List.
4.3.7 Viewing Saved Designs

To view the designs you have saved, click on the arrow in the Design List tab. Once this area is expanded, you can add folders to your design library and build hierarchies as needed.

The left navigation pane contains the Design List. My Designs contains the designs created in FilterPro. Files are NOT automatically saved in this folder. Designs must be saved by selecting File from the menu bar and choosing Save Design.
5 Changing Components in FilterPro Desktop

Changing components is a powerful way to customize a design in FilterPro Desktop. The design is built using generic information so the user can customize the design as needed.

5.1 Changing Component Values in the Schematic

![Figure 28. Changing Component Values](image)

Items in the schematic are either red or blue.

- **Red Label**: Items in red are not available for editing. These are labels identifying certain aspects of the schematic.
- **Blue Label**: Items in blue are available for editing. Change the component values by hovering the mouse cursor to the value of the component and clicking it. You should see a box around the number in blue. Enter the value that needs to be changed.

**Smart Input**: There may be instances where the value is too great or small (for example, 0.0000002). In this case, values can be entered as absolute or they can be entered in the standard units as noted in Table 2.

<table>
<thead>
<tr>
<th>Number</th>
<th>Prefix</th>
</tr>
</thead>
<tbody>
<tr>
<td>(10^{-15})</td>
<td>f</td>
</tr>
<tr>
<td>(10^{-12})</td>
<td>p</td>
</tr>
<tr>
<td>(10^{-9})</td>
<td>n</td>
</tr>
<tr>
<td>(10^{-6})</td>
<td>u</td>
</tr>
<tr>
<td>(10^{-3})</td>
<td>m</td>
</tr>
<tr>
<td>(10^3)</td>
<td>k</td>
</tr>
<tr>
<td>(10^6)</td>
<td>M</td>
</tr>
<tr>
<td>(10^9)</td>
<td>G</td>
</tr>
</tbody>
</table>
5.2 Modifying Resistors and Capacitors

The resistors and capacitors can be selected from any of the standard E6 to E192 series from the drop-down menu in the schematic tab view at the top right corner of the schematic.

The default setting is the ‘Exact’ (ideal) values calculated for that filter design. As soon as you change the component tolerance, the values are chosen closest to that ideal value from the series you picked and all components are recalculated. This allows you to scale the computer-selected resistor values to match the application. For example, when the circuit is in a power-sensitive environment (battery power, solar power, etc.), the value can be increased to decrease power consumption. Some high-speed op amps require lower feedback resistance, so the seed resistor value should be decreased.

Higher resistor values, such as 100kΩ, can be used with FET-input op amps. At temperatures below about +70°C, dc errors and excess noise due to op amp input bias current are small. Remember, however, that noise due to the resistors is increased by √n where n is the resistor increase multiplier.

Lower resistor values, such as 50Ω, are a better match for high-frequency filters using a wide range of high-speed amplifiers from Texas Instruments.

Compared to resistors, capacitors with tight tolerances are more difficult to obtain and can be much more expensive. Unless capacitor entries are made, FilterPro selects capacitors from standard E6 (six values per decade) values. When values other than E6 are used (E12, measured, etc.), then the appropriate values should be entered manually.

5.3 Compensate for Op Amp Input Capacitance: Sallen-Key Only

If the common-mode input capacitance of the op amp used in a Sallen-Key filter section is more than approximately C1/400 (0.25% of C1), it must be considered for accurate filter response. You can use the capacitor entry fields to compensate for op amp input capacitance by simply adding the value of the op amp common-mode input capacitance to the actual value of C1. The program then automatically recalculates the exact (or closest 1%) resistor values for accurate filter response. No compensation for op amp input capacitance is required with MFB designs.

6 Capacitor Selection

Capacitor selection is very important for a high-performance filter. Capacitor behavior can vary significantly from ideal, introducing series resistance and inductance, which limit Q. Also, nonlinearity of capacitance versus voltage causes distortion.

Common ceramic capacitors with high dielectric constants, such as high-K types, can cause errors in filter circuits. Recommended capacitor types are: NPO ceramic, silver mica, or metallized polycarbonate; and, for temperatures up to +85°C, polypropylene or polystyrene.

7 Op Amp Selection

It is important to choose an op amp that can provide the necessary dc precision, noise, distortion, and speed. While FilterPro assumes the use of ideal op amps, Texas Instruments offers an excellent selection of op amps that can be used for high-performance active filters. To aid in selection of the op amp, a feature in FilterPro allows you to view pole-pair section fN and Q below each stage in the Schematic tab. The fN and Q information is also useful when troubleshooting filters by comparing the expected to the actual response of individual filter sections.

The following sections define parameters that should be evaluated when selecting op amps for filter circuits.
7.1 **Op Amp Gain Bandwidth Product (GBP)**

In a low-pass filter section, maximum gain peaking is very nearly equal to Q at \( f_n \) (the section’s natural frequency). So, as a rule of thumb:

- For an MFB section: Op amp GBP should be at least \( (100 \cdot \text{GAIN} \cdot f_n) \). High-Q Sallen-Key sections require higher op amp GBPs.
- For a Sallen-Key section: For \( Q > 1 \), op amp GBP should be at least \( (100 \cdot \text{GAIN} \cdot Q^2 \cdot f_n) \). For \( Q \leq 1 \), op amp GBP should be at least \( (100 \cdot \text{GAIN} \cdot f_n) \).
- For a real-pole section: Op amp GBP should be at least \( (50 \cdot f_n) \).

Although Q is formally defined only for complex poles, it is convenient to use a Q of 0.5 for calculating the op amp gain required in a real-pole section.

For example, a unity-gain, 20kHz, five-pole, 3dB ripple Chebyshev MFB filter with a second pole-pair \( f_n \) of 19.35kHz and a Q of 8.82 needs an op amp with unity-gain bandwidth of at least 17MHz. On the other hand, a five-pole Butterworth MFB filter, with a worst-case Q of 1.62, needs only a 3.2MHz op amp. The same five-pole Butterworth filter implemented with a Sallen-Key topology would require a 8.5MHz op amp in the high-Q section.

**NOTE:** The FilterPro display of required op amp GBP in the schematic tab is always calculated using \( (100 \cdot \text{GAIN} \cdot f_n) \), regardless of filter topology.

7.2 **Op Amp Slew Rate**

For adequate full-power response, the slew rate of the op amp must be greater than \( (\pi \cdot V_{opp} \cdot \text{Filter Bandwidth}) \). For example, a 100kHz filter with 20V\(_{pp}\) output requires an op amp slew rate of at least 6.3V/\( \mu \)s.

7.3 **Full Power Bandwidth**

The op amp should have a full-power bandwidth which is at least the same as the highest frequency of the signal which is to be passed.

7.4 **Current-Feedback Amplifiers**

Although it is possible to configure current-feedback amplifiers as filters, neither the MFB nor the Sallen-Key topologies should be used for a low-pass filter using values defined by FilterPro.

7.5 **Fully-Differential Amplifiers**

FilterPro 3.1 can design fully-balanced filters using a fully-differential amplifier in the MFB topology. Figure 30 shows a filter using a fully-differential amplifier in this topology.
The UAF42 Universal Active Filter

For other filter designs, consider the Texas Instruments' UAF42 universal active filter. It can easily be configured for a wide variety of low-pass, high-pass, band-pass, or band-reject (notch) filters. It uses the classical state-variable architecture with an inverting amplifier and two integrators to form a pole-pair. The integrators include on-chip 1000pF, ±0.5% capacitors. This architecture solves one of the most difficult problems in active filter implementation—obtaining tight tolerance, low-loss capacitors at a reasonable cost.

Simple design procedures for the UAF42 allow implementation of Butterworth, Chebyshev, Bessel, and other types of filters. An extra FET-input op amp in the UAF42 can be used to form additional stages or special filter types such as an inverse Chebyshev. For more information, download the UAF42 product data sheet from the TI website.

Design Tools

Design Report in FilterPro Desktop

You are able to print directly from FilterPro Desktop by selecting the Design Report tab at any time, to print information before or after changes have been made to the design. You may also save a version of the design report. Click the Design Report tab to display the print option and all the pages of the design. This tab includes the specifications used to create the design, schematic, gain and phase responses, group delay plot, response data at key frequencies, and the bill of materials. You have the option to print a report of the information that has been generated about the design.
9.2 Exporting Design Data in FilterPro

Exporting design data is sending the current information displayed on the screen to an Excel file. The data can then be saved as a read-only file, and sent via email to another user. The recipient will not be able to modify the original file.

The views that can currently be exported to Excel are:
1. Data
2. BOM

9.2.1 Exporting a Design

When you export a specific view of a design, the Excel icon will appear in the bottom of the page. This indicator lets you know that the information displayed can be exported.

Export a design by doing the following:
• Access a tab that contains the Excel icon.
• Click on the Excel icon to initiate the export.
• Choose to either save or open the file.
  – If the choice is to open the file, once the information is displayed in Excel format, change the information displayed and save the file.
  – If the choice is to save the file, choose a location for the file to access later. The filename defaults to the name of the screen. Change the filename if necessary for quicker retrieval.
9.3 Printing Designs in FilterPro

Print directly from FilterPro by selecting the Print icon that is located in the Design Report tab at any time to print information before or after changes have been made to the design.

![Design Report](image)

**Figure 32. Print a Design Report Through the Printer Icon in the Upper Left Toolbar Area**

In order to print a design, there must be an active design displayed on the screen. To print, click on the Print icon to initiate the print option. The current design will be sent to print.

The secondary toolbar includes the following options:

- **Print**: Prints the design report. Select a printer and print options for the design needed
- **Copy**: Activates when you select text from the design report. Highlighted text can be copied into another application (such as Word, etc.)
- **Zoom In**: Increases the size of the content
- **Zoom Out**: Decreases the size of the content
- **100%**: Displays the information on the page at 100%
- **Page Width**: Displays the content in page width format
- **Whole Page**: Displays the whole page on the screen
- **Two Pages**: Displays two pages on the screen
9.4 Managing Designs in FilterPro Desktop

Managing designs in FilterPro is similar to working with Windows Explorer navigation.

9.4.1 Saving Designs

To save your design, select File from the menu bar, and then Save Design.

![Figure 33. Save a Design from the File Menu](image)

The window that opens is the default location your files will be saved when working in FilterPro. The default location for designs is $\text{My Documents}\backslash\text{Texas Instruments}\backslash\text{FilterPro}\backslash\text{My Designs}$. Name the file and then select Save.

![Figure 34. Save As... Dialog](image)

The window that opens is the default location your files will be saved when working in FilterPro. The default location for designs is $\text{My Documents}\backslash\text{Texas Instruments}\backslash\text{FilterPro}\backslash\text{My Designs}$. Name the file and then select Save.

**NOTE:** All FilterPro designs contain the extension `.fpd`.
9.4.2 Viewing Saved Designs

There are three ways to view previously saved designs. The first option is to click on the arrow in the Design List tab, as Figure 35 shows. Once this area is expanded, you can open files, add folders to your design library, and build hierarchies as needed.

![Design List](image)

**Figure 35. Selecting a Design from the Design Manager**

The second method is to select *File* from the menu bar and then select *Open Design*, as Figure 36 shows.

![File Menu](image)

**Figure 36. Opening a Design from the File Menu**

The third way is to select the Open Design icon from the tool bar, as illustrated in Figure 37.

![Toolbar Icon](image)

**Figure 37. Opening a Design from the Toolbar Icon**
9.4.3 Editing Designs

To rename, copy or delete any item in the tree, the folder must first be expanded to display the file that requires an action. Once this is done, you are able to make any changes needed.

![Design Manager Contextual Menu](image)

**Figure 38. Design Manager Contextual Menu**

To interact with a design previously created, mouse over the design to be affected and click the right-mouse button. A menu will appear with the following options:

- **Rename:**
  
  Click on the Rename option to rename the design. A text box will appear on the screen. Change the name as preferred for the design. In addition, the schematic will appear in the center pane. To lock in the new design name, click on **OK**.

  ![Rename Dialog](image)

  **Figure 39. Rename Dialog**

  Click on the Rename option to rename the design. A text box will appear on the screen. Change the name as preferred for the design. In addition, the schematic will appear in the center pane. To lock in the new design name, click on **OK**.

- **Make a Copy:** Click on the Make a Copy option to make a copy of the design clicked. The copy will be named the same as the current design with Copy of . . . in the design name. Change the name of the copy or leave as is to identify the copy from the original.

- **Delete:** Click on the Delete option to delete any design that is no longer needed. No confirmation message will appear so be sure the design is no longer needed when deleting files.

10 Migrating Designs from FilterPro v2.0

FilterPro Desktop v3.1 allows you to migrate designs from FilterPro v2.0 so that designs are not lost. You will be able to open and edit any designs that you have previously saved in FilterPro v2.0.

These are the steps to migrate a design from FilterPro v2.0 to v3.1:

Before opening FilterPro v3.0, determine the location of the FilterPro v2.0 files. Once this is known, they can be migrated. (You may have to open v2.0 to find the location of your designs.) After locating the files, open FilterPro v3.0. There is no need for the wizard for this exercise, so it can be closed.

Go to the title bar and select File and then Open Design. Navigate to the directory where the FilterPro v2.0 files are stored.

To see the files from v2.0, change the file type to FilterPro 2.0 Design File (*.fpf) so you can see the v2.0 files. Select the file you want to save in v3.0 and click on Open (NOTE: You can only open one file at a time.) The schematic for the filter will appear on the screen. The migrated file will be un-named in v3.0.

You are now able to save the file by selecting File from the title bar and then Save Design As... Enter the name of the file to be saved and click on save.

NOTE: The filename from v2.0 is not retained in v3.0, so the file must be named again.
11 Important Notes

11.1 FilterPro Auto-Update in Windows7

FilterPro needs administrator privileges to run the auto-update in Windows7. You can grant this privilege to FilterPro by enabling the Run as Administrator checkbox in the desktop shortcut as described here.

Right-click on the FilterPro Desktop shortcut and then select Properties in the menu.

Figure 42. Windows 7 Desktop Properties Selection

Figure 43. Setting Privilege Level in Desktop Properties

11.1.1 Designs Missing in the Design Manager

The tree is mapped to your My Documents\Texas Instruments\FilterPro\My Designs folder. All the FilterPro designs in this folder are visible in the tree. If you save a design outside this folder, then you will not find the design in the tree. However, you can still access your designs by going to the directory in which you saved your files.
11.1.2 Look of Navigation Buttons in Design Wizard

This is the FilterPro Design Wizard:

![FilterPro Design Wizard](image)

Figure 44. Correct Look of Filter Design Wizard
If your wizard does not look like Figure 44, does it look like the screen in Figure 45 instead?

If your wizard looks like Figure 45, it is because you may have the visual settings on your computer set for Best Performance rather than Best Appearance. To change these settings, follow these steps.

Step 1. Right click on My Computer and go to Properties.

If your wizard looks like Figure 45, it is because you may have the visual settings on your computer set for Best Performance rather than Best Appearance. To change these settings, follow these steps.

Step 1. Right click on My Computer and go to Properties.
Step 2. In the Advanced tab, click on Settings for Performance.

![Image of System Properties with Settings button highlighted]

Figure 47. Settings Button in System Properties

Step 3. In the Visual Effects tab of the Performance Options pop-up window, select the option, Let Windows choose what’s best for my computer.

![Image of Performance Options window with Visual Effects tab selected]

Figure 48. Selecting Performance Options
11.2 **Examples of MFB Filter Response**

Figure 49 and Figure 50 show actual measured magnitude response plots for fifth-order, 20kHz Butterworth, 3dB Chebyshev, and Bessel filters designed with the program. The op amp used in all filters was the OPA627. As can be seen in Figure 49, the initial rolloff of the Chebyshev filter is fastest and the rolloff of the Bessel filter is the slowest. However, each of the fifth-order filters ultimately rolls off at \(-N \times 20\) dB/decade, where N is the filter order (\(-100\) dB/ decade for a 5-pole filter).

![Figure 49. Gain vs Frequency for Fifth-Order 20kHz Butterworth, Chebyshev, and Bessel Unity-Gain MFB Low-Pass Filters, Showing Overall Filter Response](image)

![Figure 50. Gain vs Frequency for Fifth-Order 20kHz Butterworth, Chebyshev, and Bessel Unity-Gain MFB Low-Pass Filters, Showing Transition-Band Detail](image)
The oscilloscope photographs (Figure 51 through Figure 53) show the step response for each filter. As expected, the Chebyshev filter has the most ringing, while the Bessel has the least. Figure 54 shows distortion plots vs frequency for the three filters.

![Figure 51. Step Response of Fifth-Order, 20kHz Butterworth Low-Pass MFB Filter](image1)

![Figure 52. Step Response of Fifth-Order, 20kHz Chebyshev Low-Pass MFB Filter](image2)

![Figure 53. Step Response of Fifth-Order, 20kHz Bessel Low-Pass MFB Filter](image3)

![Figure 54. Measured Distortion for the Three 20kHz MFB Low-Pass Filters](image4)

12 Conclusion

Using FilterPro, the designer can develop active filters for many different applications without the need for complex calculations.

This user guide can be used as a supplement to the built-in help available in FilterPro, which is accessible from the Help menu or toolbar button.

For further support, go to [http://www.ti.com/e2e-filterpro](http://www.ti.com/e2e-filterpro) to access our online support forum.
## Revision History

**Changes from B Revision (October, 2010) to C Revision**

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Corrected Q condition for GBP recommendation; changed &quot;≥ 1&quot; to &quot;≤ 1&quot;</td>
</tr>
</tbody>
</table>

**NOTE:** Page numbers for previous revisions may differ from page numbers in the current version.
IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, modifications, enhancements, improvements, and other changes to its products and services at any time and to discontinue any product or service without notice. Customers should obtain the latest relevant information before placing orders and should verify that such information is current and complete. All products are sold subject to TI's terms and conditions of sale supplied at the time of order acknowledgment.

TI warrants performance of its hardware products to the specifications applicable at the time of sale in accordance with TI's standard warranty. Testing and other quality control techniques are used to the extent TI deems necessary to support this warranty. Except where mandated by government requirements, testing of all parameters of each product is not necessarily performed.

TI assumes no liability for applications assistance or customer product design. Customers are responsible for their products and applications using TI components. To minimize the risks associated with customer products and applications, customers should provide adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any TI patent right, copyright, mask work right, or other TI intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information furnished by TI regarding third-party products or services does not constitute a license from TI to use such products or services or a warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual property of TI.

Reproduction of TI information in TI data books or data sheets is permissible only if reproduction is without alteration and is accompanied by all associated warranties, conditions, limitations, and notices. Reproduction of this information with alteration is an unfair and deceptive business practice. TI is not responsible or liable for such altered documentation. Information of third parties may be subject to additional restrictions.

Resale of TI products or services with statements different from or beyond the parameters stated by TI for that product or service voids all express and any implied warranties for the associated TI product or service and is an unfair and deceptive business practice. TI is not responsible or liable for any such statements.

TI products are not authorized for use in safety-critical applications (such as life support) where a failure of the TI product would reasonably be expected to cause severe personal injury or death, unless officers of the parties have executed an agreement specifically governing such use. Buyers represent that they have all necessary expertise in the safety and regulatory ramifications of their applications, and acknowledge and agree that they are solely responsible for all legal and regulatory requirements concerning their products and any use of TI products in such safety-critical applications, notwithstanding any applications-related information or support that may be provided by TI. Further, Buyers must fully indemnify TI and its representatives against any damages arising out of the use of TI products in such safety-critical applications.

TI products are neither designed nor intended for use in military/aerospace applications or environments unless the TI products are specifically designated by TI as military-grade or "enhanced plastic." Only products designated by TI as military-grade meet military specifications. Buyers represent and acknowledge that any such use of TI products which TI has not designated as military-grade is solely at the Buyer's risk, and that they are solely responsible for compliance with all legal and regulatory requirements in connection with such use.

TI products are neither designed nor intended for use in automotive applications or environments unless the specific TI products are designated by TI as compliant with ISO/TS 16949 requirements. Buyers acknowledge and agree that, if they use any non-designated products in automotive applications, TI will not be responsible for any failure to meet such requirements.

Following are URLs where you can obtain information on other Texas Instruments products and application solutions:

<table>
<thead>
<tr>
<th>Products</th>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>Communications and Telecom</td>
</tr>
<tr>
<td>Amplifiers</td>
<td>Computers and Peripherals</td>
</tr>
<tr>
<td>Data Converters</td>
<td>Consumer Electronics</td>
</tr>
<tr>
<td>DLP® Products</td>
<td>Energy and Lighting</td>
</tr>
<tr>
<td>DSP</td>
<td>Industrial</td>
</tr>
<tr>
<td>Clocks and Timers</td>
<td>Medical</td>
</tr>
<tr>
<td>Interface</td>
<td>Security</td>
</tr>
<tr>
<td>Logic</td>
<td>Space, Avionics and Defense</td>
</tr>
<tr>
<td>Power Mgmt</td>
<td>Transportation and Automotive</td>
</tr>
<tr>
<td>Microcontrollers</td>
<td>Video and Imaging</td>
</tr>
<tr>
<td>RFID</td>
<td>Wireless</td>
</tr>
</tbody>
</table>

TI E2E Community Home Page
e2e.ti.com

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2011, Texas Instruments Incorporated